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Introduction
1. Introduction
The percentage of old people against younger people has grown considerably
during the last few decades in the developed countries and is expected to
increase further in the next few decades (1). This demographic shift will have
significant impact on oral health care services. More older people will face more
teeth loss, morbidity and disabilities and consequently will need an increasing
proportion of oral health care services like removable dental prosthesis (RDP) (1,
2). Nevertheless, many surveys of adult dental health indicate that the prevalence
of RDP in

high developed countries is slightly decreasing, but with great

differences between countries, geographical regions within countries and
between groups with various backgrounds and age (3-5). This decrease came
mainly from Complete Denture wearers (CD). More subjects had maintained a
residual dentition and were wearing removable partial dentures, but the decrease
in CD use was greater than the increase in removable partial denture RPD use (611). The percentage of edentulous was estimated to continue to decrease into
the next century (12, 13). Nevertheless, the provision of replacement removable
dentures to those currently edentulous or the construction of RDP for new
patients will present a considerable task to the dental profession (12, 13). Besides,
those patients who have RDP are becoming more clinically demanding either
because of oral conditions present at the time of tooth loss or the deterioration
(12). And since tooth loss may impair oral function, esthetics and phonation, the
need for RDP to restore the dentition will keep its momentous in the near future
(14, 15).
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2. Literature review
2.1 What Is Biofilms?
Biofilms are composed of microorganisms attached to surfaces and encased in a
hydrated polymeric matrix containing polysaccharides, proteins, and nucleic acids
(16). Biofilm formation is a way used by microorganisms to ensure their survival
(17). In nature, most microbes live as communities in biofilms (17). Bacteria and
other microbes embedded in a self-produced and secreted matrix of extracellular
polymeric substances (17, 18). Life in a biofilm provides protection to outrage
from the surrounding environment, and facilitates survival under hard conditions
and environmental insults such as ultraviolet radiation, physicochemical stresses,
desiccation, and insufficient supply of nutritive resources (16, 17, 19).

2.2 Formation and Development of Biofilms
Biofilms grow in a three-stage process as shown in, figure 1. The first stage
includes the attachment of bacteria to the substratum. This attachment is often
a response to intercellular messenger molecules such as acylated homoserine
lactones (AHLs) which are used to detect a surface or a high density of cells in the
local environment (20). The second stage is the microorganisms growth, which
leads to the colonization of the surrounding area and the formation of the biofilm.
The third stage includes the biofilms disperse, allowing cells to spawn new biofilm
communities elsewhere. Through the last stage, the biofilm developmental cycle
closes full circle (16).
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Figure 1 The Biofilms development process: 1, 2 attachment. 3, 4 colonization
and maturation. 5 dispersion. The figure is edited from a figure in:
http://www.nature.com/nrd/journal/v2/n2/fig_tab/nrd1008_F1.html
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2.3 Denture plaque
Chalmers defined dental plaque as a natural biofilm composed of various
microorganisms that tenaciously attach to the teeth and other oral surfaces (21).
Plaque on RDP is a dense layer of microorganisms and their metabolites, that can
develop on the surface of complete denture (CD) or removable partial denture
(RDP) (22). Briefly, denture plaque is a classic example of a biofilm that builds up
on the RDP.
Like soft and hard intra-oral tissues, immediately after being placed into the oral
cavity, the RDP surface begins to be coated with a layer of salivary glycoproteins
and immunoglobulins called

`acquired pellicle´ (23-25). Stedman's Medical

Dictionary defined acquired pellicle as a thin film (about 1 µm), derived mainly
from salivary glycoproteins, that forms over the surface of a cleansed tooth crown
when it is exposed to the saliva (26). Salivary molecules such as proline-rich
peptides, statherin, and amylase, are attached on the oral surfaces and the RDP
surfaces to form an acquired pellicle, which provides receptors to which only
certain microbes are able to attach. Subsequently, salivary glycoproteins act as a
nutrient source for the growth of the colonizing organisms (27). On the other
hand, the bacterial capsule, which is an amorphous, gelatinous layer, mediates
3
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the adhesion of bacteria to human tissues or prosthesis such as dentures or
implants (28). This adhesion is a prerequisite for colonization and infection (29).
The Glycocalyx (slime layer) covers the outer surfaces of many bacteria and
allows the bacteria to adhere firmly to various structures, e.g. oral mucosa, teeth,
RDPs, heart valves and catheters, and contribute to the formation of biofilms (29).
Once the microorganisms adhere to the RDP, they usually tend to aggregate and
form intelligent communities of cells embedded in a matrix of polymers of host
and bacterial origin (30, 31). Microorganisms produce Extracellular Polymeric
Substances (EPS), that is a complex mixture of biopolymers primarily consisting of
polysaccharides, as well as proteins, nucleic acids, lipids and humic substances
(32). EPS create the intercellular space of microbial aggregates and form the
architecture and building of the biofilm matrix (32). Plaque maturation (Figure 2)
involves the growth of the attached bacteria to produce a structurally- and
functionally-organized biofilm (29). The structure of this community is not flat
and compressed but comprise a complex architecture with towers and mushroom
or dome-shaped structures with water channels that permit transport of
metabolites and nutrients (29). The maintenance of open water channels in
multispecies biofilms requires interspecies signalling to direct growth and exopolysaccharide production away from the channels (33). The microorganisms in
the biofilm communicate via the signal molecule Autoinducer. Miller and Bassler
defined Autoinducer as signalling molecules that are produced in response to
changes in cell-population density (34). Plaque maturation is characterized by
increasing quantity and diversity of micro-organisms on the RDP surface. But the
growth rate has been shown to be far slower than planktonic cells. This is thought
to be due reduced level of nutrient supply as a result of the dense population of
cells within a biofilm structure (35). After 7 days, it was noticed that streptococci
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are the main organisms present, but after 14 days there is a shift to anaerobic
rods and filaments (36).
Figure 2 Summary of plaque development on RDP. The figure is designed by the author
according to Bagg et al. in his textbook: Essentials of microbiology for dental students (36).
Clean Surface of the
RDP.

After 2 seconds:
Acquired pellicle (black
colour).
…………………

After 1 minute: Pioneer
bacteria (yellow
colour).

2 Hours: Microcolonies
and extracellular
polysaccharide.

2 Hours onwareds:
Biofilm development
(different forms and
colours represent
different types of
bacteria).

48 hours: Mature
plaque.
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2.4 Biofilm resistance
Because Biofilms possess a high resistance to antimicrobials, immune cell and
antifungal treatment, they gained notoriety ability to cause clinically refractory
disease (35, 37-39). The structure of the biofilm matrix, reduce the ability of
antifungal or antimicrobial agents to penetrate and diffuse through the biofilm
(37). Besides, some microorganisms in the biofilm have the ability to alter the
membrane protein composition resulting in a reduction in cell permeability to
antimicrobial agents (37). Moreover, it was noticed the increasing presence of
multidrug efflux pumps in many biofilms, which can exude antimicrobials (37,
38). Therefore, some researchers reported that, bacteria grown in a biofilm can
be up to 1,500 times more resistant to antibiotics, biocides, and immune
chemicals compared to the same bacteria grown suspended in liquid culture (16).
For example, Streptococcus sanguinis grown in biofilm increase its tolerance to
Chlorhexidine 10 – 50× MIC (MIC = minimum inhibitory concentration of
planktonic cells) (27). Streptococcus sobrinus grown in biofilm increase its
tolerance to Amine Fluoride 75× MBC (MBC = minimum bacteriocidal
concentration of planktonic cells),

and to Chlorhexidine about 300× MBC.

Porphyromonas gingivalis grown in biofilm increase its

tolerance to

Metronidazole 2 – 8× MBC to Doxycycline 4 – 64× MBC, and to Amoxicillin 2 – 4×
MBC (27).

2.5 The microflora of denture plaque
Normal oral flora is taking an important role in keeping the oral mucosa in a health
status (39). There are many factors influencing the oral microbial community
structure, such as (40, 41):
-

General

factors:

Age, infancy,

pregnancy,

medicaments, immunity system, diet……
6
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- Local factors: Oral hygiene, saliva quality and quantity, teeth (eruption and
the loss of teeth), insertion of partial or complete dentures, trauma,
smoking.
Differences in the microflora of denture plaque are highly variable between
healthy sites and sites with denture stomatitis. Even the microflora of healthy
sites is highly variable between the fitting and the exposed surfaces. In general,
denture plaque contains complex heterogeneous layer of microorganisms and
their metabolites, that includes more than 1011 organisms/g (wet weight) (22).
The first step in understanding the role of bacteria in oral diseases is the
comprehensive insight into the normal microflora (42). For instance, streptococci
(especially mutans streptococci) and sometimes Candida spp are commonly seen
in the relatively stagnant area on the denture-fitting surface, because plaque
tends to be more acidogenic (43). Mutans streptococci and members of the mitisgroup of streptococci are the primary microorganisms on complete dentures
(27). Obligate anaerobes including A. israelii and low proportions of Gram
negative rods are also detected in denture plaque. Staphylococcus aureus – which
is a species found commonly in the mucosa of patients with denture stomatitis can also be isolated from denture plaque over healthy sites (27).
On the other hand, many researchers stated that, approximately 90% of cases of
denture-related stomatitis are thought to be caused by yeasts, typically Candida
albicans, although other species, such as C. parapsilosis, C. tropicalis, C. glabrata,
C. krusei, C. guilliermondii and C. dubliniensis, may also contribute to the
pathogenesis of the disease (44-46). Yeasts and bacteria have the ability to cause
damage to the oral mucosa, and colonize the surfaces of the RPD as a biofilm
more than oral mucosa (44, 45, 47). However, the mucosa beneath the dentures
is sparsely colonized with bacteria, irrespective of whether or not the subjects
had denture-related stomatitis (48).
7
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Moreover, dentures can serve as a reservoir for halitosis-causing oral bacteria.
Halitosis-related species like F. nucleatum, T. forsythia, V. atypica and K.
pneumoniae were detected in denture plaque (49).

2.6 Oral diseases caused by RPD
Oral mucosa lesions associated with RDP may represent acute or chronic
reactions to bacterial plaque adhering to RDP, a mechanical denture injury, or a
reaction to the material of the RPD (41, 50). The direct factor for oral mucosa
lesions associated with RDP is the presence of the removable dentures in the oral
cavity. It is also important to mention that mucosal lesions related to RDP are
induced in many cases by multiple factors (41). The main predisposing factors
can be divided into (41, 50-52):
A- Systemic factors: 1. Physiologic, old age, pregnancy (41).
2. Nutritional deficiencies, iron, folate, or vitamin B12
.

deficiency (53-55)……….
3. High-carbohydrate diet (28, 56).
4. Endocrine disorders, diabetes mellitus,

.

hypothyroidism (57-60)…...
5. Immune defects, immunosuppression, AIDS,

.

Sjogren's syndrome, thymic aplasia (52, 61-63)………
6. Acute leukemia, agranulocytosis, malignancies
(64-66).
7. Irradiation (41).
8. Drug therapy, Broad-spectrum antibiotics,

.

corticosteroids (61-63)…….
B- Local factors:

1. Xerostomia (41).
2. Smoking tobacco (67).
3. Fungal infection (68).
8
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4. Changes in environmental conditions, trauma, denture
usage (how long), denture plaque, denture cleaning

.

(method / material) (69-71).
Lesions of the oral mucosa associated with wearing RPD include (Figure 3):
1. Denture Stomatitis (also called (72-74) denture-related stomatitis, denture
sore mouth, denture stomatitis, chronic atrophic candidiasis, Candidaassociated

denture

induced

stomatitis,

and

denture-associated

erythematous stomatitis) is a term that has been applied to an inflammation
of the denture-bearing mucosa which may affect as many as two-thirds of an
elderly population of denture wearers (75, 76). Laskaris stated that denture
stomatitis is a tissue response to microorganisms living beneath the dentures
(77). Newton in 1962 classified denture stomatitis according to clinical
criteria into three types (78):
Type I / pin-point hyperaemic: Localized simple inflammation which is
.

associated with trauma.

Type II / generalized simple inflammation: Diffuse erythema confined to the
.

mucosa contacting the denture.

Type III / granular surface: Inflammatory papillary hyperplasia only resolved
.

by surgery.

Improvement of RDP fit and occlusion, oral and RDP hygiene, and topical
antimycotics are important steps in denture stomatitis treatment (77).
Besides, it is always important to consider the role of systemic disease and its
impact on oral function and homeostasis.
2. Angular Cheilitis (also called (73, 79-82) rhagades, perlèche, cheilosis, angular
cheilosis, commissural cheilitis, or angular stomatitis) is inflammation and
atrophy of the skin folds at the angles of the mouth, well known among
denture wearers (79). The lips may exhibit cracking, fissures, atrophy,
9
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erythema, moist maceration, and ulceration that are exaggerated at the
corners of the mouth (81). This may come from the excessive lip licking,
thumb sucking, sagging of facial skin in edentulous or elderly persons, or RDP
with reduced vertical dimension leads to overclosure (81). The prolonged
contact with saliva results in maceration, with possible secondary infection
by Candida albicans or staphylococci (83). Treatment consists of correcting
the occlusal vertical dimension, and applying topical steroids and/or
antifungal ointments (77).
3. Burning mouth syndrome: Burning mouth syndrome BMS is characterized by
a burning sensation in one or several oral structures of long - term duration
without any detectable local or systemic causes (84, 85). In this disease, the
patients express a wide range of oral complaints without visible tissue
changes (83). Despite considerable studies conducted on this topic, its
aetiology and pathogenesis are still unknown and, as a consequence, there is
no causal and/or effective treatment (86, 87). It typically affects women over
the age of 50 and wear complete dentures (85). The symptoms often appear
for the first time in association with the placement of new dentures (84).
Appropriate counselling of the patient, to help him understand the benign
nature of the problem, with subsequent elimination of fears is the first main
step in disease management. A large variety of Medicines, neuroprotective
drugs and therapies have been proposed in BMS treatment. Sadly, the
treatment management of this syndrome is still not satisfactory (86-88).
4. Traumatic ulcers (sore spots): Traumatic ulcers are common oral lesions, that
can be caused by RDPs irritation / high stresses and lateral movements.
Traumatic lesions are usually the result of imperfections in or on the surface
of the tissue side of the RDP base. Disharmony in occlusion in either the
centric or the eccentric jaw positions can also produce sore spots. Errors in
10
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denture design may cause a denture to move excessively over the mucosa
and enhance the occurrence of sore spots (89). For example, incorrect
fabrication of the metal frameworks or denture base may increase the
functional stress on the mucosa or interfere with the freedom of movement
of the surrounding muscles and that may initiate a complaint of burning or
frank soreness (90).
Chronic irritation is generally regarded as a modifier rather than an initiator
of oral cancer (83). Mechanical trauma from ill-fitting dentures, broken
fillings and other factional rubs factors is unlikely to cause oral cancer. These
factors will probably hasten the process of cancer, if a cancer is started from
another cause (83).
Treatment of traumatic ulcers consists of occlusal adjustment and basal
surface refining.
5. Denture-induced hyperplasia (Also termed flabby gums, denture fibroma or
flabby ridges). Denture-induced hyperplasia takes the form of single or
multiple flaps of fibrous tissue related to the border of a denture (90). The
fibrous tissue is a reactive lesion arising from excessive and chronic
mechanical pressure on the vestibular oral mucosa. Lesions develop slowly as
a result of overextension of denture border or gradual resorption of alveolar
bone, causing the denture to sink so that its borders dig into the mucosa (50).
Denture-induced hyperplasia is found in up to 10% of denture wearers (50,
91). The lesions can reach a considerable size before the patient becomes
aware of the offending denture (90).
Treatment consists of eliminating denture trauma and recalling after 2 weeks.
If the size of the lesion is still too large to allow adequate extension of the
denture, surgical removal is indicated.

11
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6. Papillary hyperplasia: Papillary hyperplasia or palatal papillomatosis is a
painless papillomatous lesion of hard palate in denture wearers (83). The
lesion is composed of multiple small nodules that are ovoid to spherical and
measuring 2 to 3 mm in diameter on an erythematous background as a result
of inflammation (92). The precise cause of papillary hyperplasia is not well
understood, although it appears almost exclusively on the hard palate and
almost always in association with an ill-fitting or loose removable prosthesis,
that creates a potential space between the denture base and tissue (92).
Other causes like poor denture hygiene or wearing the denture 24 hours a
day are also mentioned by some researchers (93). Tissue hyperplasia has also
been related to the presence of the fungal organism in the setting of lowgrade chronic trauma (92, 94, 95).
Removal of the RDP may allow the erythema and edema to subside, and the
tissues may return to its normal appearance. The condition also may show
improvement after topical or systemic antifungal therapy (95). For more
advanced lesions, hyperplastic tissue should be removed before adjusting the
old RDP or fabrication of a new one. This may be achieved with a scalpel, a
fluted burr on a rotary instrument, electrocautery, or laser surgery (96).
7. Contact allergic stomatitis: RDP dental materials occasionally induce allergic
reactions locally (contact allergic stomatitis) as well systemically
(anaphylactic shock and palmoplantar pustulosis) (97-99). Denture-induced
allergic stomatitis is a rare acute or chronic allergic reaction, caused by
denture materials or denture cleansing agents (77). Clinically, erythema,
edema, vesicles, erosions, and occasionally ulcers may be seen. A burning
sensation is a common symptom. Removal of suspected allergens, topical or
systemic steroids, and antihistamines are the followed measures in treating
contact allergic stomatitis (77).
12
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Figure 3 Oral mucosal lesions related to RDP.
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In addition to what were mentioned previously, there are many other direct and
indirect sequelae caused by wearing RRP like: caries, root caries, periodontal
disease (especially around the abutments), gagging, residual ridge reduction,
atrophy of masticatory muscles, nutritional deficiencies, oral galvanic currents
and altered taste perception (22, 84, 100).
Finally, many recent studies demonstrated relationships/associations/mutualistic
interactions between oral plaque/oral health/periodontitis and systemic diseases
such as diabetes, tissue repair capacity, immune cell functions……. (101, 102).
Oral plaque microorganisms may disseminate through the blood to infect the
vascular endothelium and contribute to the occurrence of atherosclerosis and risk
of myocardial ischemia and infarction (103).

Sumi et al. proved the high

correlation between the bacterial species in denture plaque and pharyngeal
microflora (104). Besides, denture plaque could serve as a reservoir for
disseminated infections such as gastrointestinal infections (105).
The new studies enhance our understanding of the importance of oral health and
its connection to the patients’ overall health and their intraoral and general
diseases. Disease can be treated not only by targeting the putative pathogens,
but also prevented by proper oral and RDP care:

2.7 Materials and methods for cleaning RPD
RDPs require proper care to keep them clean, free from stains and looking their
best. Two major approaches are generally recommended to patients for the
removal of denture plaque and stains (figure 4). RDPs can be cleaned
mechanically or chemically (106). Mechanical methods can be further subdivided
into: manual (by hand) or machinal (ultrasonic device or rotating needles device).
In this thesis, the term ’mechanical method’ will be used when plaque is mainly
removed by a mechanical force. It is important to mention that nearly all
14
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mechanical approaches have chemical solutions or materials (chemical method)
are used.
A- Mechanical methods
- Brushing: It is the most widely used mechanical method. The method
includes rinsing and brushing away plaque and food with water alone,
household soap, a toothpaste, denture cream or abrasives. The brush or
the whitening toothpaste can scratch the denture. The tiny scratches could
in turn increase the surface area for plaque formation (107). The degree of
scratching depends to a large extent on the diameter, length and hardness
of bristle; the stiffer the bristles the more abrasive the brush will be. Wear
is inversely related to the length of the bristles, on the contrary, the wear
is directly proportional to the diameter of the bristle (108-111).
- The ultrasonic denture cleaner is a small bathtub containing a liquid,
which has high-frequency sound waves (between 20 – 120 kilohertz)
projected through the tube. Ultrasound has two mechanisms of action, the
first is the movement of liquid resulting from sound waves transferred to
the liquid (vibration), and the second, the ultrasound within the liquid
causes tiny bubbles (microscopic cavities) to appear and collapse on RPD
surfaces, very quickly, all through the liquid (112, 113). The violent collapse
of bubbles on the dentures creates localized areas of disruption that loosen
and remove debris from the denture surface; this process is known as
cavitation (111). This is almost similar to ultrasonic scalers when used to
remove plaque and calculus from teeth (111). Ultrasonic RPD cleaner
removes denture plaque, but does not effectively reduce the number of
microorganisms, therefore the mechanical cleansing ability of the device
is improved by a adding disinfectant solution to the bathtub (109, 114).

15

literature review
- Rotating needles device (Sympro - Renfert GmbH): Rotating needles
device is a small bathtub containing cleaning solution and cleaning pins
(needles). The tub is surrounded by movable magnets. A rotary magnetic
field sets the needles in motion, which causes mechanical removal of the
denture plaque. Besides, the rotating needles heat up the cleaning solution
to approx. 45°C (113°F), which accelerates the chemical reaction according
to the manufacturer product details.
B- Chemical methods
The term ’chemical method’ will be employed when cleansing is dependent
on a chemical reaction.
Chemical denture cleaners (so-called denture cleanser), are available in the
market in different commercial brands: Periogard, Cepacol, Corega Tabs
(sodium perborate/ effervescent tablet), Milton, Mildent,

Steradent,

Polident, Renew Denture Cleaner, Efferdent…………… (115).
In chemical cleaners, RPD should be immersed entirely within a bath
containing a particular cleaner. All RPD chemical cleaners rely on a chemical
reaction to remove the denture biofilm and plaque and have a different
mode of action to achieve this mission (110, 116, 117).
Normally, denture cleaners contain more than one of these ingredients
(115, 118-121):
1.

Alkali Hypochlorite: Like sodium hypochlorite which is the main
constituent of several brands of denture cleanser. It is frequently used
as a disinfectant or a stain removal /bleaching agent. Sodium
hypochlorite can disrupt the cell membrane of microorganisms and
dissolve the mucins that collect on the RPD (109, 111, 122).

2.

Alkali Peroxide: Peroxide cleansers are commonly used and supplied in
the form of tablets and powders. Sodium perborate is soluble in water
16
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and releases hydrogen peroxide which has stain removal and bleaching
potency. Sodium perborate serves as a source of active oxygen in many
detergents, and cleaning products, and act by producing bubbles which
help to remove and disrupt microorganisms from the denture surface
by the process of cavitation. Alkali Peroxide is effective only when
dentures are soaked for several hours or overnight and are not effective
when soaked for 15-30 minutes. (109, 111, 116).
3.

Acids: Citric acid appears commonly in denture cleaners. The acid acts
as a chemotherapeutic agent that can effectively disrupt biofilms
through a sequestering mechanism with calcium ions (123). This
mechanism allows citric acid to break calcium bridges and subsequently
disrupt the biofilm matrix, which may lead to anti-biofilm activity (119,
124, 125).

4.

Sodium polyphosphate: Sodium polyphosphate is a pigment dispersant
and strong cleaning agent, normally consumed as a component of
commercial detergents and soaps.

5.

Potassium monopersulfate: Potassium monopersulfate is a powerful
oxidizer with cleaning and bleaching properties.

6.

EDTA: Ethylenediaminetetraacetic acid can be used

to remove

inorganic debris (smear layer) and loosen up calcifications on RPD
surfaces.
7.

Enzymes: Enzymes like Protease, amylase and mutanase serve in
removing denture plaque (126, 127).

8.

Additional compounds: For example, vinegar, sodium bicarbonate,
flavourings and fragrances. Dye markers that provide a color change
when the cleansing process has been completed.
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Oral rinses are considered one of the chemical methods for cleaning dentures.
They include any dental mouthwash products available for patients, such as 0.2%
chlorhexidine gluconate or 0.05% salicylate solution. They are used as a soak like
the above products and have a good range of antibacterial properties (111, 122).
Finally, it is important to mention that the British Dental Health Foundation and
International Dental Health Foundation recommend denture-wearers to avoid
using products that contain bleach, as it may weaken and discolor the RPD (128,
129). Nonetheless, manufacturers such as Cepacol, Corega and Polident
manufacture cleansers with this ingredient. Besides, oral rinses which contain
chlorhexidine solutions do tend to stain dentures with prolonged use (109, 111).
Figure 4 Materials and methods for cleaning RPD.

Materials and methods for cleaning RPD
Chemical Method

Mechanical Method
Machine

Rotating needles device

Manual
Ultrasonic device

2.8 RDP plaque assessment methods
Oral hygiene assessment is rarely carried out for RPD hygiene, because there is a
need for standardization of both the methods for RPD hygiene assessment and
RPD hygiene management. Several different methods for assessing denture
hygiene have been suggested in the current literature, but until now none has
been widely accepted. Above all, there is currently no standardized method of
assessing RPD plaque/hygiene (130-133).
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Assessing denture plaque/hygiene is a very important step to:
1- Monitoring denture hygiene.
2- Assessing and measuring patient compliance with regards to RPD hygiene.
3- Evaluating denture plaque scores before and after using mechanical or
chemical methods.
4- Compare the efficacy of different methods or devices in cleaning and
removing biofilm and denture plaque.
In general, the methods of assessing RPD plaque can be divided into 3 categories,
see table 1.
Table 1 The methods of assessing RPD plaque.
Method

Suitability
Patients’ monitoring and
Visual
motivation, and evaluating
assessment patients’ compliance with RDP
hygiene instructions.

Example
Schubert & Schubert index (132), Denture
Hygiene Index (133), Ausberger & Elahi index
(134), Tarbet index (135), Jeganathan et al.
Index (136), Budtz-Jörgensen & Knudsen Index
(137), Denture Cleanliness Index (111)……..
Paper-weighing quantification method (138),
Digital planimeter method (139),
Point-counting method (dot-grid method)
(139),
Square-counting method (140),
Computerized methods (141).

Planimetric Mostly used in the field of
assessment scientific research.

Laboratory Useful for diagnostic purposes
assessment or scientific research.

Conventional microbiological method (120),
Molecular method (142).

Before we start with the methods, it is important to explain the importance of
plaque disclosing agents:

2.8.1 Plaque disclosing agents
Biofilm and plaque detection methods vary greatly because plaque is generally
colourless (143), therefore, it should be stained prior to assessment. In many
clinical studies, biofilm and plaque are clinically detected by using biofilm
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disclosing agents and/or protein evaluation and/or microbiological quantification
(120, 134, 139, 140, 144-147). Since dental and denture plaque is usually
transparent, colourless and not easily visible, RDP wearer frequently is not aware
of the quantity or the location of plaque present in the mouth and over the RPD
(148). Therefore, it is desirable to use plaque-disclosing compositions to identify
areas of the mouth and RPD where plaque buildup is a problem. The use of
plaque disclosing agents motivates the RDP wearer and help the examiner by
showing the presence and quantity of plaque.
A number of agents have been developed, some of which may be used
conveniently and economically at home, whereas others may be used more
effectively in a dental office.
The most common plaque disclosing agents are: 1% eosin, 1% neutral red, 5%
erythrosine (most widely used), 0.05% methylene blue, 0.3% proflavine, 1% sodic
fluorescein (special UV light is needed in order to make the fluorescein dye
visible), and Replak (141, 149).
According to Silva et al. work, the agent which presents the greatest disclosing
ability and removal facility are 1% eosin, 1% neutral red and 5% erythrosine (149).

2.8.2 RDP Plaque visual assessment (indexes)
Before using or determining the most suitable index to be used within a study,
five points should be put into consideration: the population size, duration of
study, the type and extent of change anticipated, and above all, the objectives of
the study (143, 150). By literature review, only one research was founded, that
tested the discriminating power of three RDP plaque indices (151). RDP plaque
assessment by visual examination has some advantages as it is the easiest. There
is no need for special equipment, making it useful for epidemiological studies
(151). However, applying index produce problems and difficulties. The problems
come from the subjective nature of the indices and the need for examiner
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training. Besides, the calibration should be put into consideration if there is more
than one examiner. Nevertheless, if all examiners have not been extensively
calibrated to ensure intra- and inter-examiner agreements, calibration does not
necessarily grant reliability at differing times within the same centre or between
centres (143). This process will increase the time and cost of studies. Besides,
visual assessment may generate more random and systematic errors than
computer based plaque analyses because it is more subjective (151, 152). On the
other hand, computer based plaque analyses when applied on natural teeth
proved to be more reliable, (153) precise, (154) objective (153-155) and sensitive
(154, 156) than classic plaque indices. These critical points may enable the
researcher to reduce the sample size and avoid underpowered trials
simultaneously. Without doubt, reducing the sample size will reduce the cost and
time of the study. The RDP indexes generate ordinal data, but computerized
methods generate interval data which give statistical strength to the studies.
Above all, most computerized methods are able to detect and measure small
changes in plaque, it is more representative of the true plaque area coverage
(157), and can be applied on all types and surfaces of RDPs. However, it is more
sophisticated and very time consuming.

After the literature review, 12 indexes were retrieved:
2.8.2.1 Denture Cleanliness Index (DCI) (111)
DCI index can be used with upper and lower/complete and partial dentures.
Preparing the RPD: RPD is gently washed under cold water to remove loose
debris; a liquid plaque disclosing dye is applied onto the entire RPD fit surface,
and left for 30 seconds. The RPD then gently washed under cold water to remove
excess dye. The fit surface is inspected visually and scored according to the DCI
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index criteria (table 2). Based upon the DCI scores, the patient is given specific
denture hygiene instructions (table 3).
Table 2 DCI Index criteria (111).
DCI score
0
1
2
3
4
*

Index criteria
Clean denture. No plaque is visibly seen, no staining, no plaque
detectable
Denture is visibly clean. Little staining (<25% fit surface stained)
Denture has visible plaque and/or debris. Moderate staining on
the fit surface (25-50% fit surface stained)
Denture has visible plaque and/or debris. Severe staining on the
fit surface (>50% stained)
Denture has visible calculus deposits, on any surface
Visible defects in denture, in addition to any of the above scores

Table 3 Intervention modalities based on DCI score (111).
DCI score
0
1
2
3
4

*

Intervention and patent´s instructions
No intervention required, reinforce current denture
hygiene
Denture hygiene reinforcement
Denture hygiene reinforcement, patient information leaflet
Denture hygiene reinforcement, patient information leaflet
and denture hygiene kit
Intervention by clinician to clean dentures, denture hygiene
reinforcement, Patient information leaflet and denture
hygiene kit
Consider denture reline or remake (depending on the
severity of the defect)

2.8.2.2 Denture Hygiene Index (DHI) according to Prof. Wefers (133)
DHI index can be used with upper and lower / complete and partial dentures.
Retaining elements are included according to their position. The index divides the
RPD to vestibular surface, oral surface and fit surface. The assessment starts
always with the vestibular surface, which is divided into three sections; two side
sections behind the canines and one front section between the canines, see
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figure 5. The section starts from the cutting edge of the front teeth or from the
centre of the occlusal fissures on the premolars and molars to the vestibular RPD
flange edge. Similarly, the oral (palatinal or lingual) RPD surface is divided into 3
sections. The denture fit surface is divided into 4 sections by two imaginary lines;
the first is the midsagittal line and the second is between second premolar (P2)
and first molar (M1). In this way, 10 sections have been created per RDP.
- DHI Score: All 10 sections are assessed in accordance with the principle Yes/1
(presence of biofilm or denture plaque) and No/0 (clean section). The assessment
is carried out purely quantitative.
Preparing the RDP: After picking RPD from the mouth, it should be only rinsed
under running water; without brushing it.
DHI Score can be represented in one of two forms:
A- In three numbers: DHI index score can be represented in three numbers
(vestibular-oral-fit surface). It may have a value between 0-0-0 (= all surfaces
clean) to 3-3-4 (all surfaces partially or completely covered with biofilm or
denture plaque).
B- In one number: DHI index score can be represented in one number:
Total score of the DHI index = vestibular value + oral value + fit surface value.
If plaque disclosing agents is applied, the prefix "r" is added before the score.
And if mineralization is detected, the suffix "c" (calcified) is added after the
number of the affected section.
Examples:
0-2-4

.
2-3-2

0 no biofilm or plaque detected in the three RPD vestibular sections.
2 two of the three oral sections are contaminated (covered with biofilm
or denture plaque).
4 all the four fit surface sections are contaminated (covered with biofilm
or denture plaque).
2 two vestibular sections are contaminated.
3 all the tree oral sections are contaminated.
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2 two fit surface sections are contaminated.
0-1c-4 0 no plaque on the vestibular sections of the RPD.
1c one oral section is contaminated with mineralized plaque (tartar).
.
4 all the four fit surface sections are contaminated.
r2c-1c-3 letter (r) indicate the use of plaque disclosing agent.
2c two vestibular sections are contaminated with mineralized plaque.
1c one oral section is contaminated with mineralized plaque.
3 three fit surface sections are contaminated.
Prof. Wefers believe that the flexibility of this index makes it suitable for both
epidemiological studies and routinely patents’ follow-up (133).
Figure 5 The 10 sections in every RPD according to the denture Hygiene Index.
The figures are taken from: www.dental.unigreifswald.de/fpk/pdf/prothesenhygiene.pdf
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2.8.2.3 McCabe et al. scoring system for stain, plaque and calculus
(145)
This system can be used to estimate plaque accumulation on all surfaces of
complete dentures. According to our knowledge, it is the only index tried to
distinguish between stain, plaque and calculus, and score all of them separately
at the same time. The author did not mention how he distinguished between
stain, soil/calculus and disclosed Plaque.
Table 4 McCabe et al. scoring system for Stain, Plaque and Calculus.
Score
0
2

4

6

8

10

Stain
No stain
Slight stains either on
denture or teeth.
Pronounced stained
areas, but much of
denture not affected.
Considerable areas of
stain, especially on
teeth and on palate.
Greater part of
denture is stained very heavy in many
areas.
Entire denture and all
teeth heavily stained.

Soil / Calculus
No calcified deposits
Some deposits can be seen,
especially in problem areas
behind the teeth.
More general deposits. May
be solid in places.
Calcified deposits on and
between teeth and on large
areas of the denture, severe
in some areas.
Large areas of denture show
heavy deposits. Teeth also
show heavy deposits.
Heavy white encrustations
on virtually all surfaces and
on and between teeth.

Disclosed Plaque
No areas of blue
Small areas of blue only,
either on denture
or teeth.
More pronounced blue
areas, but much of denture
unaffected.
Large areas of denture and
teeth stained blue,
very heavy stains in places.
Greater part of denture and
most of teeth show
medium-heavy blue
staining.
Denture and teeth covered
in heavy blue stains.

2.8.2.4 ASKD Denture Plaque Index (ASKD-DPI) (158):
ASKD-DPI is a quantitative denture plaque index to measure plaque on the fit
(intaglio / interior) surface of complete denture.
The fit surface of the maxillary complete denture is divided into 10 areas, table 5.
Four areas on the inner crestal part of fit surface (1 - 4), three areas of flanges (5
- 7), and four areas of the rugae and posterior palatal seal (8 - 10). The fit surface
25

literature review
of mandibular complete dentures is also divided into 10 areas: three areas on the
crestal part (1 - 3), three areas of facial flange (4 - 6), and four areas on the lingual
flange (7 - 10), table 6.
Preparing the complete denture: Maxillary and mandibular complete dentures
are soaked in a bowl of water for 1 minute to remove food debris. Fifteen drops
of an erythrosine solution are poured in a bowl, having 30 ml of water at room
temperature. The dentures are soaked for 2 minutes and then rinsed under
running water for 1 minute to remove unattached dye. Pictures of disclosed
plaque on the fit surface of maxillary and mandibular complete dentures are
taken with a digital camera (158).
The index score ranged from 0 - 100%, and reflected the percentage of the fit
surface of maxillary and mandibular complete dentures that contained plaque.

Table 5 Areas of plaque retention on fit surfaces of maxillary dentures. The
table is taken from: www.perioiap.org/journals/17-2-2015-04.pdf (158).
Area designation
1
2
3
4
5
6
7
8
9

10

Plaque retention area description
Mesial of central incisor to distal of right 1st premolar
Mesial of central incisor to distal of left 1st premolar
Distal of 1st premolar to the right posterior end
Distal of 1st premolar to the left posterior end
Distal of right canine to distal of left canine
Distal of right canine to the right posterior end of flange
Distal of left canine to the left posterior end of flange
Rugae area
Posterior palatal area bounded by rugae anteriorly, mid-palatal
suture medially, rugae anteriorly, and distal flange laterally on
right side
Posterior palatal area bounded by rugae anteriorly, mid-palatal
suture medially, rugae anteriorly, and distal flange laterally on
left side
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According to Almas et al, the index can also be used to classified quantitative
percentages based on clinical observation (158):
0 - 30%

(low DPI), good denture hygiene.

31 - 70%

(moderate DPI), represent fair denture hygiene.

71 - 100% (High DPI), represent bad denture hygiene.
Table 6 Areas of plaque retention on fit surface of mandibular dentures. The
table is taken from: www.perioiap.org/journals/17-2-2015-04.pdf (158).
Area designation
1
2
3
4
5
6
7
8
9
10

Plaque retention area description
Distal of right canine to distal side of left canine
Distal of right canine to the right posterior end of crestal surface
Distal of left canine to the left posterior end of crestal surface
Distal of right canine to distal of left canine on facial flange
Distal of right canine on facial flange
Distal of left canine on facial flange
Lingual area from midline to half distance to distal end on right side
Disto-lingual half of the lingual flange on right side
Lingual area from midline to half distance to distal end on left side
Disto-lingual half of the lingual flange on left side

2.8.2.5 Prosthesis Hygiene Index PHI according to Schubert &
Schubert (132)
In 1979 Schubert, H and Schubert, U developed the first hygiene index for RPD.
The Schubert & Schubert index was originally based on direct assessment of
coloured plaque on the whole denture base (fit surface/ tissue side), without
using a photographic technique. Prosthesis hygiene index PHI is a quantitative
denture plaque and biofilm index to measure plaque on the fit surfaces of
complete dentures. It is used for classifying the cleaning level of complete
dentures.
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The denture base is divided into nine sections, figure 6. The accumulation of
plaque is assessed in each section on a scale from 0 to 4 points:
0 Absence of plaque;
1 small spots of plaque;
2 less than half covered with plaque;
3 half or more than half covered with plaque;
4 the entire section covered with plaque.
After the direct assessment of plaque in every section, the prosthesis hygiene
index score is calculated by using this formula:

𝑃𝐻𝐼 =

∑ 𝑜𝑓 𝑖𝑛𝑑𝑖𝑣𝑖𝑑𝑢𝑎𝑙 𝑠𝑐𝑜𝑟𝑒𝑠
∑ 𝑜𝑓 evaluated 𝑎𝑟𝑒𝑎𝑠 𝑜𝑛 𝑑𝑒𝑛𝑡𝑢𝑟𝑒𝑠

PHI score could vary from 0 to 4 for a denture. Denture score of less than 1.5 is
defined as excellent, from 1.5 to 2.5 as fair, and more than 2.5 as poor (159).
Figure 6 The 9 sections in upper CD according to Schubert & Schubert index.
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2.8.2.6 Ausberger and Elahi index (107, 134)
Ausberger and Elahi index can be used to estimate plaque accumulation on
complete dentures. Scoring is carried out after dividing the denture into eight
sites; 4 on the labial and buccal surfaces, and 4 on the palatal, or fitting surface,
figure 7. The plaque present in each area is scored as follows:
0 = no plaque;
1 = light plaque, 1% to 25% of area covered;
2 = moderate plaque, 26% to 50% of area covered;
3 = heavy plaque, 51% to 75% of area covered;
4 = very heavy plaque, 76% to 100% of area covered.
The mean plaque score from all 8 sites is obtained by averaging the 8 individual
scores.

Figure 7 The 8 sections in upper CD according to Ausberger and Elahi index.
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2.8.2.7 Tarbet index (135)
The Tarbet index was originally constructed to asses plaque on the fitting surface
of upper complete removable denture (intaglio surface).
The fit surface of each maxillary denture is divided into four sections
approximately equal in area by mentally drawing an anteroposterior line at the
midline and another line perpendicular to the midline at about the premolar
region. Plaque is coloured by plaque disclosing agent, and each of these
quadrants is scored as follows:
0 = no plaque;
1 = light plaque (25% or less of the quadrant covered);
2 = moderate plaque (26% to 50% of the quadrant covered);
3 = heavy plaque (51% to 75% of the quadrant covered); and
4 = very heavy plaque (76% to 100% of the quadrant covered).
A total denture plaque score was obtained by summing the quadrant scores,
(Maximum score = 16).

2.8.2.8 Jeganathan et al. Index (136)
Jeganathan et al. index is a modification of Tarbet index. The maxillary denture
is removed from the mouth and soaked in a bowel of water for 1 minute to
remove food debris. Plaque disclosing agent (Erythrosine) is applied on the fitting
surface and left for 1 minute. The denture is rinsed under running tap water to
remove the unbound dye. The disclosed denture plaque is scored as follows:
0= no visible biofilm;
1= light biofilm (1 to 25% of the fitting surface covered by biofilm);
2= moderate biofilm (26 to 50% covered);
3= heavy biofilm (51 to 75% covered);
4= very heavy biofilm (76 to 100% covered).
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2.8.2.9 Budtz-Jörgensen & Knudsen Index (137, 160)
This index is also for the fitting surfaces of the complete denture. The distribution
of the plaque is analysed by the following criteria:
0 (Excellent): no visible biofilm;
1 (Good): 1/3 or less of the fitting surface covered with plaque;
2 (Fair): between 1/3 and 2/3 coverage; and
3 (Poor): 2/3 or more covered.

2.8.2.10 Modified Quigley-Hein scale according to Keng et al. (161,
162)
The Quigley-Hein scale is a plaque scoring system developed 1962 to assess
plaque accumulation on the front normal teeth (161). A modified Quigley-Hein
scale according to Keng et al. was developed to estimate plaque accumulation on
complete dentures. The denture is divided into four areas: teeth (including the
gingival margins), palate, flange, and fitting surface, and each of these areas is
scored as follows:
0

no visible plaque

1

0% to 25% of denture area covered with plaque;

2

26% to 50% of denture area covered;

3

51% to 75% of denture area covered; and

4

76% to 100% of denture area covered

The scores of all the surfaces are combined to give the total score.

2.8.2.11 Modified Quigley-Hein scale according to Palenik et al. (161,
163)
A modified Quigley-Hein scale according to Palenik et al. can be used to estimate
plaque accumulation on complete dentures. This scale divides the complete
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dentures for scoring purposes into three large areas: “teeth,” “palate,” and
“tissue side”. Each of these large segments is further divided into 40 equal sized
squares, which is surveyed individually for visible plaque according to this table:
0

no visible plaque

1

0% to 25% of denture area (square) covered

2

26% to 50% of denture area covered

3

51% to 75% of denture area covered

4

76% to 100% of denture area covered

Scores from the squares for each of the large divisions are pooled and averaged.
The average scores from the large divisions are then added together to determine
the total plaque score for each denture.

2.8.2.12 Abelson index (164)
Abelson, D stated that: the process by which dentures accumulate plaque, stain,
and calculus is apparently similar to that process which takes place on natural
teeth. Therefore, he developed a plaque index to measure plaque accumulation
around denture teeth.
0

No stainable plaque.

1

Discrete, discontinuous plaque.

2

Thin layer of continuous lightly stained plaque.

3

Layer of intensely red staining plaque (up to 1 mm).

4

Same as No. 3, but material covers more than 1 mm of tooth surface and

.

less than one-third of the tooth.

5

Same as No. 3, but material covers more than one-third of the tooth.
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2.8.3 Laboratory assessment
These methods can be divided into two main categories:

2.8.3.1 Molecular method
Monitoring denture hygiene by measuring the rate of oxygen consumption is a
method invented by Cardash et al. (142). According to Cardash et al., simple and
rapid test for measuring oral hygiene can be done by measuring the rate of
oxygen consumption of oral expectorates of milk. The denture is immersed in 10
ml of sterile milk and agitated for 2 minutes. 3 ml of the previous milk was added
to test tubes containing methylene blue. The time required for colour change at
the bottom of the test tube, which is indicative of the rate of oxygen consumption,
is recorded. The recorded time is correlated with the amount of plaque on
dentures.

2.8.3.2 Conventional microbiological method
Taking swabs from the surface of the RPD is a well-known laboratory method to
isolate, identificate and quantify the microorganisms associated with RPD.
Gram-positive bacteria, gram negative bacteria, anaerobic bacteria, aerobic
bacteria, and yeast can be detected by this method (45, 68, 120, 165-171).

2.8.4 Planimetric assessment
In this method, an image or images are captured of the RPD in standard
conditions. The images are processed in one of these methods:

2.8.4.1 Paper-weighing quantification method
The areas of interest (covered with biofilm) are outlined using a lead pencil or
other colouring method. Then, the areas of interest are cut using scissors and the
resulting shapes are weighed using a precision scale (139).
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Silva et al. projected the obtained slides (photos) on paper (10 X amplification)
and the total and stained surfaces were outlined with graphite, cut off and
weighed (149).

2.8.4.2 Digital Planimeter method
A digital Planimeter is a measuring instrument used to determine (measure the
size) the area of an arbitrary two-dimensional shape. In this method, the figures
representing the areas (parts of the total image which is covered with plaque) are
measured using a digital Planimeter (139, 172-174), figure 8.

Figure 8 Digital Planimeter
(Placom KP 92N, Tokyo, Japan).

2.8.4.3 Point-counting method
A commonly-used method of estimating the area of a region on a map or image
is the dot-grid method (175). Transparent sheet with points (+) on it is placed on
the image and the number of points on the targeted area are counted (139, 172174), figure 9.

Figure 9 Transparent sheet with
points (+) on it is placed on an
image.

34

literature review
2.8.4.4 Square-counting method / Square-grid system
In this method, the photo of fit surface of complete denture is projected against
a screen with over 100 squares. The presence of plaque was recorded per squares
of the grid system (140).

2.8.4.5 Computerized methods
A software like, Adobe Photoshop (157) , ImageTool 2.02 (Texas, USA) (151),
Scion Image (141) or Optimas 6.51 image analysis software (Media
Cybernetics,Silver Spring, MD, USA)(176) were used to measure the covered
parts with plaque or the total recognized surface of the RPD.
One of the first computerized methods was computer-graphic analysing system
developed in Japan by Minagi et al. 1987. The method was applied on CDs. The
system consist of a camera and a microcomputer. Minagi et al. did not describe
how they used the system, but they stated that this system showed high
reproducibility (146).
Paranhos and Silva (139) tried to compare between the previous planimetric
methods (except the square-counting method) and founded that all the four
quantitative methods were efficient for measuring quantity of plaque in complete
dentures, and may be useful in experimental studies. They also found that, the
computerized method with ImageTool software is fast and easy to perform in
complete dentures.
Shimura et al. used the computerized method with Adobe Photoshop to assess
the relation between the shape of the retainers and the plaque formation on
abutment teeth. In their study, they tested the reliability of the of standardized
photography, but they did not test the reliability of plaque assessment. They
mentioned, that they had repeated pixels counting three different times with
three different pictures and the average pixels were calculated (177).
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Coulthwaite et al. used two softwares to assess plaque on CD; Adobe Photoshop
and Scion Image. They did not describe how they used the softwares and they
did not mention that they have tested the reproducibility of their method to
assess plaque on CD (141).
Salles et al. used Adobe Photoshop 5.5 and Image Tool 2.0 software (UTHSCSA–
University of Texas Health Science Center, San Antonio, TX, USA). They also did
not test the reproducibility of their method to assess plaque on CD (178).
Fernandes et al. used Adobe Photoshop 5.5 software and new version (3.0) of
Image Tool software to compare the efficacy of three denture brushes on biofilm
removal. They also did not test their denture plaque assessment method.
Coulthwaite and Verran founded that computerized method is more
representative, sensitive and less subjective than the visual plaque assessment
(157).

2.9 Adobe Photoshop
Adobe Photoshop is a worldwide used tool for editing, annotating, enhancing and
analysing digital images (179). Digital images play a key role in the work of medical
professionals, whether in a diagnostic workflow, communication of findings, or
patient education.
Physicians, dentists, and other medical professionals can strengthen
communications with patients by presenting procedures alongside before-andafter images, and share findings with peers. Scientists can optimize images for
both visual appreciation and further automated analysis. For example,
dermatologists could use the Count tool to show skin changes by quantifying and
tracking skin changing

(wrinkles/texture, ptosis, vascular disorders, and

pigmentation disorders) over time (180, 181).
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Previous researchers used Adobe Photoshop to asses biofilm, dental plaque and
denture plaque (143, 157, 176, 182-184). When Adobe Photoshop® is used
properly with good digital image, it can provide detailed colour data in a relatively
short period of time, and create a customized colour profile for each image (185).
Above all, Adobe Photoshop allows quantitative and qualitative analysis of the
data in digital image (186). Measurement, counting, and other analysis tools in
Photoshop facilitate performing qualitative and quantitative analysis. Therefore,
it was the chosen software in this study.
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3. Aims and Objectives
3.1 First objective
The first aim of this study was to evaluate reliability and agreement of a new
computerized planimetric method for measurement and assessment of plaque
on all types of RPDs.

3.2 Second objective
The second was to test the previous instrument (computerized planimetric
method) by evaluating the efficacy of the rotating needles device in cleaning
specific parts of RPDs:
- the vestibular flange and the occlusal and vestibular surfaces of the
artificial teeth (base(B-O)),
- and the veneer (facing) of the secondary crown in double crown retained
removable denture.
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4. Materials and Methods
4.1 Participants (study population) and the inclusion/exclusion criteria
Our target population was patients with RDPs who were treated in the dental
school of Greifswald University. All of the participants were patients who had
received and adapted to their RDPs for at least two months. Additionally, the
participants did not have any intraoral or extraoral pathologic findings or mental
disorders. The study was approved by the medical ethics committee (RegNo:
BB141/10). Participants gave their written consent to all study procedures.
Forty-nine participants (29 female) with 65 RDPs were included, aged 32–88 years
with a mean age of 62.

4.2 Standard Operating Procedure (SOP)
- Preparing the RDP for photography: After an RDP was removed from the mouth,
it was rinsed under running water for 5 to 10 seconds (according to the size of the
RDP) to remove any loose food particles (without brushing). Next, the RDP was
dried with jets of air for a further 5 to10 seconds. Five percent erythrosine was
applied on all RDP surfaces and was left for 1 minute. Finally, the RDP was rinsed
under running water to remove the unbound dye for 5 to 10 seconds and dried
with jets of air for 5 to 10 seconds.
- Photography: For every RDP, a plaster plate with an individual silicon key was
fabricated to fix the RDP. The silicon key was used to secure the RDP on the plate
in the same position and angle before taking the images. The plate was fixed with
a magnet on a movable base, which can be tilted forward, backwards, left and
right at ±45̊. A Canon EOS/450D (Canon Inc. Japan) with an objective MR-14EX
Macro Canon ultrasonic 60 mm f/2.8 and Ring flash (MR-14EX TTL Macro Lite
Flash) were used. The camera’s manual settings were: ISO: 100, exposure: 200,
aperture: 22, and white balance: flash. The camera was held with an adjustable
reprostand; Hama Reprostativ RS 20, figure 12.
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Six images were taken for every RDP under the same light conditions: front,
back, left, right, occlusion and base (intaglio surfaces/ tissue side). The first 4
images (front, back, right and left) were taken at a 45-degree angle, and the last
2 images were taken at a 90-degree angle.
Figure 10 The plaster plate and the movable base.

Figure 11 The movable base was tilted 45o to the left to make a photo of the
lingual surface of the right side and the buccal surface of the left side.

- Cleaning the RDP: After taking the photos, every RDP was cleaned with the
rotating needles device (Sympro - Renfert GmbH) in Universal Sympro fluid for 20
minutes and 1.600 rotational speed (RPM) according to the company instructions.
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- Rephotography: After picking the RDP from the device, it was rinsed under
running water for 10 seconds to remove the cleaner (Universal Sympro fluid).
Subsequently, the RDP was dried with jets of air for 5 to10 seconds. Plaque
disclosing agent (5% Erythrosine) was applied on all RDP surfaces and left for 1
minute. Then, the RDP was rinsed under running water to remove the unbound
dye for 5 to 10 seconds and dried with jets of air for 5 to 10 seconds. Finally the
RDP was reattached on the silicon key and the 6 photos were retaken in the same
positions, angles and light condition.
Figure 12 The camera, the reprostand, and the RD is placed on the movable
base.
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Three hundred and ninety (65x6) images were taken before the rotating needles
device, and 390 images were taken after. From this database (780 images), 55
images were randomly selected for image analysis.
- Image analysis: Adobe Photoshop Version:CS5 EXTENDED 12.0X32 was used for
Photo analysis, according to this SOP, which was given to all examiners:
A. Browsing folders and opening photos
Clicking the File tab will open the computer's drives and folders, enabling the
examiner to navigate the computer's folders to locate the image that he want to
view, figure 13.

Figure 13 Opening the targeted photo.
B. Duplicate layer (your photo)
In the Layers panel, you could see your photo as a layer.
1. Select your layer (photo) in the Layers panel.
2. Do one of the following
o

Drag the layer to the Create a New Layer button, figure 14.
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o

Choose the layer you want to Duplicate (your photo) → click
the right button of the mouse → choose duplicate layer,
figure 14 .
Figure 14 How to duplicate a layer. .3

C. Selection
In this step, the examiner isolates one or more parts of the image, by selecting
specific areas. In the image, we could see the metal, acrylic veneers on double
crowns, acrylic resin bases and artificial teeth. We select only the acrylic veneers
and acrylic resin bases with artificial teeth using the Magnetic Lasso tool. The
Magnetic Lasso tool is one of three lasso tools available in Photoshop: the simple
Lasso tool, the Polygonal Lasso and the Magnetic Lasso. The Magnetic Lasso tool
can be found as the third icon from the top in the toolbox., figure 15. When the
Magnetic Lasso tool is used, the border snaps to the edges of defined areas in the
image. It is especially useful for quickly selecting objects with complex edges set
against contrast backgrounds.
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Figure 15 The Magnetic Lasso tool.

After choosing the Magnetic Lasso tool, the features in the options bar should
be set as demonstrated in figure 16.
Figure 16 The values in the options bar of the Magnetic Lasso tool.

How do we use the Magnetic Lasso tool? Click the edge of the targeted part to
set the first fastening point. Fastening points anchor the selection border in place.
Release the mouse button and then move the pointer along the edge you want
to trace. As you move the pointer, the active segment snaps to the strongest edge
in the image, based on the detection width set in the options bar. Periodically, the
Magnetic Lasso tool adds fastening points to the selection border to anchor
previous segments. If the border does not snap to the desired edge, click once to
add a fastening point manually. Continue to trace the edge, and add fastening
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points as needed. To erase recently drawn segments and fastening points, press
the Delete Key until you’ve erased the fastening points for the desired segment.
Close the border manually with a magnetic segment, by dragging over the starting
point and clicking. After you close the border copy, paste your selection to create
a new layer.
D. Select a color range (plaque selection)
Colour Range selection can be used to create selections that are based on similar
colour values. Opening the Colour Range panel can be achieved by clicking Select
→ Colour Range, figure 17. In the colour range window, the Sampled colours tool
from the Select menu should be chosen, and both the Localised Colour Clusters
box and the invert option box are unchecked, see figure 8.

Figure 17 Opening the Colour Range panel.
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Figure 18 The colour range window.

The Fuzziness value has a major effect on the colour range selection; therefore,
the Fuzziness slider should not be changed, and should remain the same in all
images. In this study, the Fuzziness was 10. The first selection starts with the
darkest red part of the image. Then the plus eyedropper selects lighter red to
expand the colour range until all needed spots (plaque) in the layer are included,
figure 18. If there are spots or areas that should not be included in the selection,
the minus eyedropper is used.
Assessing the selection is accomplished by choosing White and Black Matte in the
Selection Preview menu, figure 19.
After reaching the optimal selection, OK is clicked, and subsequently a new layer
is created by the copy and paste.
In some rare cases, the Localised Colour Clusters (in the colour range box) is used
to avoid selecting unwanted areas in the image. This will increase the number of
the needed selection, but it will make the selection more satisfactory.
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Figure 19 White Matte to evaluate the selected areas.
.

Exceptionally, the eraser tool is used to remove unwanted selected areas.
Pencil Mode and Opacity of 100% in the options bar are selected during this
step. The examiner makes 2 colour selections to control his work. If he is not
satisfied, he should make a third and last selection. The mean of these two or
three selections is considered the final result.
E. Saving, closing and then reopening
Saving the work by clicking (File → Save as), this will save all the work as a PSD
file. Finally, reopen the PSD file to record the number of pixels.
Closing and then reopening the PSD file give the software the ability to
determine the correct number of pixels.
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F. Counting the total number of pixels in the selected layer
This can be accomplished by opening the histogram panel. Choose Window →
Histogram, and then click the Histogram menu and check both Expanded View
and Show Statistics, figure 20.
Figure 20 The choices in the
Histogram panel.

Figure 21 The number of pixels
in the selected layer.

In the Histogram panel, these two choices should be made:
- In channel, select the (colours).
- In source, select the (selected layer).
In the Histogram panel, the number of pixels is presented.
The percent of plaque (POP) on the targeted part of the RDP is calculated using
the following formula:
𝑃𝑂𝑃 𝑜𝑛 𝑡ℎ𝑒 𝑡𝑎𝑟𝑔𝑒𝑡𝑒𝑑 𝑝𝑎𝑟𝑡 𝑜𝑓 𝑅𝐷𝑃 =

𝑃𝑖𝑥𝑒𝑙𝑠 𝑜𝑓 𝑃𝑙𝑎𝑞𝑢𝑒
𝑃𝑖𝑥𝑒𝑙𝑠 𝑜𝑓 𝑡ℎ𝑒 𝑡𝑎𝑟𝑔𝑒𝑡𝑒𝑑 𝑝𝑎𝑟𝑡

x 100

If the targeted part of the RDP is divided over more than one image, the below
formula is applied:
∑𝑃𝑖𝑥𝑒𝑙𝑠 𝑜𝑓 𝑃𝑙𝑎𝑞𝑢𝑒 [𝑖𝑚𝑎𝑔𝑒 1+2+3+⋯ ]

𝑃𝑂𝑃 𝑜𝑛 𝑡ℎ𝑒 𝑡𝑎𝑟𝑔𝑒𝑡𝑒𝑑 𝑝𝑎𝑟𝑡𝑠 𝑜𝑓 𝑅𝐷𝑃 = ∑𝑃𝑖𝑥𝑒𝑙𝑠 𝑜𝑓 𝑡ℎ𝑒 𝑡𝑎𝑟𝑔𝑒𝑡𝑒𝑑 𝑝𝑎𝑟𝑡 [𝑖𝑚𝑎𝑔𝑒 1+2+3+⋯ ] X 100
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4.3 Examiners
The image analysis for each image was obtained by the main examiner 2 times in
different sessions, one week apart and 1 time by 3 other examiners over a period
of two weeks each. All examiners were students in Greifswald University and were
previously trained in the use of Photoshop software.

4.4 Randomisation and blinding
From the database (780 images), 55 images were randomly selected for image
analysis.
To ensure examiner blinding, the images were identified by codes in random
order and analysed anonymously. One, two or three layers were created after the
third step of photo analysis, which is isolating the targeted parts of the photo
before making colour selection (plaque selection). Every layer was considered a
single photo. A total of 111 images (layers) underwent plaque selection to
evaluate the reliability and agreement of the CPM.

4.5 Statistical analysis
4.5.1 Study’s first objective
The first aim of this study was to evaluate the reliability and agreement of a new
computerized planimetric method for measurement and assessment of plaque
on RPD.
Descriptive statistics were calculated for all examiners to show the dispersion of
the image analysis results. The normality of the data was checked by the Shapiro
Wilk test, Q-Q-plots and histograms.
Following the recommendation by Shrout & Fleiss, the ICC(2,1) was calculated for
both the intra- and inter-examiner (rater) reliability, which considers both
examiners and images as random factors (187). The inter-examiner reliability
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ICC(2,1) was calculated by comparing the main examiner mean with the results of
the other three examiners. The ICC(2,1) was used to assess whether the
standardised image analysis can be effectively used by a variety of examiners
(187).
Three parameters were used to estimate agreement: the standard error of
measurement (SEMagreement), the smallest detectable change at the 95%
confidence level (SDC95%), and the limits of agreement at the 95% confidence
level (LoA95%). The variance components needed for calculating the SEMagreement
were estimated using the restricted maximum likelihood method. De Vet et al.
recommendations were taken into consideration for calculating both the
SEMagreement and SDC95% (188).
The Bland and Altman method (analysis of differences) is one of the best methods
for quantifying agreement between the main examiner and each examiner by
constructing limits of agreement on a visual aid (plot). The resulting visual aid is
an XY plot, in which the Y axis shows the difference between the main examiner
and the other examiner, and the X axis represents the average of their measures.
In other words, the difference is plotted against the mean of the two examiners.
The Bland and Altman method was used to determine the systematic error
between the main examiner and each examiner, to investigate the existence of
any systematic difference between the measurements (i.e., fixed bias) and to
calculate the LoA95% (189). This formula was used to calculate LoA95%:
Lower/Upper limits of agreement = mean difference ± (1.96+ standard deviation SD).

4.5.2 Study’s second objective
The second aim of this study was to test the previous instrument (computerized
planimetric method) by evaluating the efficacy of the rotating needles device in
cleaning specific parts of RPDs.

50

Materials and Methods
In the database, only 34 subjects were found with double crown retained
removable denture and veneer over the secondary crown. Our statistical level of
analyses was the subject. In other words, each subject was considered as a
statistical unit, and if the subject has two RDPs, only one was randomly selected.
Finally, 49x2 (before x after) images for 34 RDPs went under image analyses to
calculate POP before and after cleaning the RDPs with the rotating needle device
in Universal Sympro fluid for 20 minutes and 1.600 RPM.
Descriptive statistics were calculated to show dispersion of the image analysis
results. The normality of the data was checked by the Shapiroe Wilk test, Q-Qplots and histograms.
The POP data were statically analysed using nonparametric Wilcoxon signedrank test because the data was not normally distributed. The test was applied to
compare between plaque accumulation on base(B-O) and veneer before and after
using the rotating needle device
Wilcoxon signed-rank test was used to estimate the efficacy of the device on
both base(B-O) and veneer. In this test we have used the pixels of plaque before
and after, instead of using the POP. This was accomplished after controlling the
Pixels of the targeted part in the photo before and the photo after. The values
should be approximately stable in both photos. If not, this means there is no
standardization in taking the photos or the selection of the targeted part has a
low reliability. The Pixels of the targeted part in both photos was statistically
tested by ICC(2,1).
The third and last question in this part of the thesis was comparing the efficacy of
the rotating needle device on both parts of the RDP by applying the formula:
𝑅𝑒𝑙𝑎𝑡𝑖𝑣𝑒 𝑝𝑙𝑎𝑞𝑢𝑒 𝑟𝑒𝑚𝑜𝑣𝑎𝑙 (𝑅𝑃𝑅) =

𝑃𝑖𝑥𝑒𝑙𝑠 𝑜𝑓 𝑃𝑙𝑎𝑞𝑢𝑒 𝑏𝑒𝑓𝑜𝑟𝑒− 𝑃𝑖𝑥𝑒𝑙𝑠 𝑜𝑓 𝑃𝑙𝑎𝑞𝑢𝑒 𝑎𝑓𝑡𝑒𝑟
𝑃𝑖𝑥𝑒𝑙𝑠 𝑜𝑓 𝑃𝑙𝑎𝑞𝑢𝑒 𝑏𝑒𝑓𝑜𝑟𝑒
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Figure 22 Basic steps in the image analysis for the second objective:

A. Selecting the targeted part; A1 the veneer and A2 the base(B-O),
B. Plaque selection; B1 selecting the plaque on the veneer and B2 selecting
the plaque on the base(B-O).

This was also accomplished after controlling the Pixels of the targeted part in the
photo before and the photo after. The formula above can be used if we have an
ICC value for the Pixels of the targeted part before/after >0.9.
P value below 5% were accepted as statistically significant. The statistical
analyses were performed using SPSS 23.0 (SPSS, Inc, Chicago, Illinois, United
States).
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5. Results
5.1 Results of study’s first objective
The first aim of this study was to evaluate the reliability and agreement of a new
computerized planimetric method for measurement and assessment of plaque
on RPD. 49 participants (29 f, 20 m) were included, having 65 RDPs, age between
32–88 years with a mean age 62. 6x2 images were taken for every RDP - before
and after using the rotating needles device - under the same light conditions:
front, back, left, right, occlusion and fit surfaces. Finally a database of 780 images
was created. 55 photos were randomly selected for photo analysis. To ensure
examiner blinding, the 55 images were identified by codes and analysed
anonymously.
Image analyses were obtained by the main examiner 2 times in different sessions,
one week apart and 1 time by 3 other examiners over a period of two weeks each.
One, two or three layers were created after the third step of photo analysis, which
is isolating the targeted parts of the photo before making colour / plaque
selection. Every layer was considered a single photo. At the end, 111 photos
(layers) went under colour / plaque selection.
Descriptive statistics were calculated for all examiners to show dispersion of the
photo analysis results. Normality of the data was checked with Shapiroe Wilk test,
Q-Q-plots and histograms, see table 7 and figures 22,23,24 and 25. The significant
in Shapiro-Wilk test, are lower than 0.05 (the typical alpha level), so we reject the
null hypothesis that the data are not different from normal.
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Table 7 Test of Normality.
Shapiro-Wilk
Statistic Valid data
Main examiner *
Second examiner
Third examiner
Fourth examiner

Sig.

0.975

111

0.035

0.970
0.951
0.952

111
111
111

0.014
<0.001
0.001

* Normality test of the mean of the first and second readings of the main
examiner.

Figure23 Normal Q-Q plot and histogram of the main examiner (mean).
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Figure 24 Normal Q-Q plot and histogram of the second examiner results.

Figure 25 Normal Q-Q plot and histogram of the third examiner results.

Figure 26 Normal Q-Q plot and histogram of the fourth examiner results.
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Q-Q plot, histogram, skewness, and kurtosis indicate the data are not normally
distributed and exhibits positive skewness, see tables 8 and 9, and figures
22,23,24 and 25.
The median and range presented first in the descriptive statistics table because
the median is more representative than the mean when the data are
asymmetrically distributed (190), tables 8 and 9.
Table 8 Descriptive statistics of image analysis for the main examiner in the first
and second readings.
Main examiner
1st reading

2ed reading

Valid data

111

111

Missing data
Median

0

0

29.01

29.27

Range

85.48

69.06

Minimum

.99

.87

Maximum

86.47

69.92

Skewness

.517

.305

Kurtosis

.08

-.71

Mean

30.40

29.97

Std. Deviation

17.21

16.82

The first step of image analysis is the selection; the examiner isolated one or
more parts of the image. Both the intra-examiner and inter-examiner reliability
had excellent ICC (1.00 to 0.98). In the last step of image analysis (counting pixels
and calculating the POP), both the intra-examiner and inter-examiner reliability
were also excellent, ICC >0.85 at 95% CI, table 10. According to Fleiss, ICC values
above 0.75 may be taken to represent excellent reliability (191).
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Table 9 Descriptive statistics of photo analysis for all examiners.
Main examiner

2ed examiner

3ed examiner

4th examiner

Valid data

111

111

111

111

Missing data

0

0

0

0

Median

29.38

28.63

27.72

27.09

Range

77.27

78.13

73.74

76.75

Minimum

0.93

0.00

0.61

0.29

Maximum

78.20

78.13

74.35

77.04

Skewness

0.38

0.34

0.35

0.47

Kurtosis

-0.39

-0.31

-0.66

-0.51

Mean

30.19

28.95

29.50

28.83

Std. Deviation

16.84

17.766

17.33

19.38

Table 10 Intra-examiner and inter-examiner reliability in the first and last step
of image analysis.
95% Confidence level
ICC*
Lower
Upper
Bound
Bound
The first step of
Intra-examiner ICC 1.000
1.000
1.000
photo analysis** Inter- examiner ICC 0.98
0.97
0.99
The last step of
Intra-examiner ICC
photo analysis *** Inter- examiner ICC

0.96

0.94

0.97

0.89

0.86

0.91

*
Intraclass correlation coefficients.
** Selection, the examiner isolates one or more parts of the image.
*** Colour / plaque selection, counting pixels and calculating the percent of
.
plaque (POP) on the targeted part of the RDP.
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Three parameters were used to estimate the agreement. The first two
parameters were Standard Error of Measurement SEMagreement and Smallest
Detectable Change at the 95% confidence level SDCagreement95%, table 11.
Table 11 Intra-rater and inter-rater agreement values.
Intra-rater
Inter-rater

SEMagreement* SDCagreement95%**
3.52%
9.76%
5.96%
16.51%

* SEMagreement
Standard Error of Measurement agreement.
** SDCagreement95% Smallest Detectable Change at the 95% confidence level.

The third parameter was the limits of agreement at 95% confidence level
according to Bland and Altman analysis. A Bland-Altman plot was used to assess
the level of agreement between the main examiner and the other three
examiners. The Bland and Altman method started with a one-sample t test of
differences. The mean value of the difference is the estimated bias, and the
standard deviation of the differences measures the random fluctuations around
this mean (the estimated bias), table 12. In the one-sample t test, the p-value
was bigger than 0.05. This indicates that the mean value of the difference does
not differ significantly from 0. In other words, there is no presence of fixed bias.
After calculating the LoA95%, a scatter plot was constructed to reveal the
agreement between the main examiner and each examiner, figures 26-28.
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Table 12 one-sample t test of differences between main and each examiner.
t **
df ***
P****
Estimated Bias*****
Diff. main vs. second * 1.807
110
0.073
1.232
Diff. main vs. third
1.405
110
0.163
0.683
Diff. main vs. fourth
1.747
110
0.083
1.355
*
Differences between main and second examiner.
**
Test statistic t
***
Degrees of Freedom.
**** Significance level P (2-tailed).
***** Mean value of the difference

Figure 27 Bland-Altman Plot for main examiner vs. second examiner.

LoA(95%)** 15.32

dmean* 1.23

LoA(95%) -12.86

*…...dmean (estimated bias), represents the mean difference between main
.
. ..examiner and second examiner.
** LoA(95%), limits of agreement at 95% confidence level.
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Figure 28 Bland-Altman Plot for main examiner vs. third examiner.

LoA(95%) 10.73

dmean 0.68

LoA(95%) -9.36

Figure 29 Bland-Altman Plot for main examiner vs. fourth examiner.
LoA(95%) 17.35

dmean 1.35

LoA(95%) -14.66
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5.2 Results of study’s second objective
The second objective of the study was to evaluate the efficacy of the rotating
needles device in cleaning specific parts of RPD; the base(B-O) and the veneer. All
images in the database for double crown retained removable denture with veneer
over the secondary crown were selected. 49x2 (before x after) images for 34
patents (16 men) wearing 34 RDPs (17 upper jaw) went under image analyses.
All RDPs are ≥ 3 years old.
Table 13 Descriptive statistics of image analysis before and after cleaning the
RDPs with rotating needles device.

POP
After

**POP
Before

Pixels
After

* Pixels
Before

*** 95% CI
for Mean
Targeted part
of RDP
Base(B-O)

N

Median

Mean
5371.18

Lower
Bound
4390.35

Upper
Bound
6352.01

****
SD
2811.07

Skewness
1.14

Kurtosis
0.7

*****
P-value
0.01

34

4507.25

Veneer

34

1291.25

1382.03

1157.15

1606.91

644.52

0.29

-1.05

0.06

Base(B-O)

34

1845.75

2188.25

1720.06

2656.44

1341.83

0.68

-0.47

0.04

Veneer

34

830.25

897.49

746.72

1048.25

432.11

0.57

-0.17

0.28

Base(B-O)

34

34.86

39.47

33.59

45.35

16.85

0.59

-0.61

0.07

Veneer

34

50.89

57.93

50.21

65.66

22.14

0.48

-0.86

0.02

Base(B-O)

34

13.49

17.75

12.95

22.54

13.73

1.48

2.14

<0.01

Veneer

34

35.70

40.46

32.96

47.96

21.50

0.65

-0.80

0.01

*
Pixels (number of pixels) of plaque.
**
POP; Percent Of Plaque
***
CI; Confidence Interval
****
SD; Standard Deviation
***** P-value in Shapiro-Wilk test

If the P-value in Shapiro-Wilk test is bigger than 0.05, we will accept the null
hypothesis Ho that the data are not different from normal. In other words, if the
P-value of the Shapiro-Wilk test is greater than 0.05, the data is normal. Normal
Q-Q plot and histogram should not show a distinguish violation of normality, table
13 and figures 30, 32 and 33. On the other hand, if the P-value in Shapiro-Wilk
test is lower than 0.05, we reject the null hypothesis Ho that the data is not
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different from normal. Normal Q-Q plot and histogram should confirm this finding
by indicating departures from normality, table 13 and figures 30,31, 29, 31,34, 35
and 36.

Figure 30 Normal Q-Q plot and histogram of the pixels (number of pixels) of
plaque on the Base(B-O) before cleaning the RDPs with the rotating needles device.

Figure 31 Normal Q-Q plot and histogram of the pixels of plaque on the Veneer
before cleaning the RDPs with the rotating needles device.
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Figure 32 Normal Q-Q plot and histogram of the pixels of plaque on the Base(B-O)
after cleaning the RDPs with the rotating needles device.

Figure 33 Normal Q-Q plot and histogram of the pixels of plaque on the Veneer
after cleaning the RDPs with the rotating needles device.
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Figure 34 Normal Q-Q plot and histogram of POP on the base(B-O) before cleaning
the RDPs with the rotating needles device.

Figure 35 Normal Q-Q plot and histogram of POP on the veneer before cleaning
the RDPs with the rotating needles device.
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Figure 36 Normal Q-Q plot and histogram of POP on the base(B-O) after cleaning
the RDPs with the rotating needles device.

Figure 37 Normal Q-Q plot and histogram of POP on the veneer after cleaning
the RDPs with the rotating needles device.
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Testing normality helped in choosing the most appropriate statistical test for
every data set in the study. For example, paired sample t-test will be used if the
data is normally distributed. On the other hand,

nonparametric tests like

Wilcoxon signed-rank test should be chosen if the data set showed a violation of
normality.
Before starting data analyses, we have checked the number of pixels of the
targeted part in the image before and the image after. Because the targeted part
should be approximately stable in both photos. This was done for both base(B-O)
and veneer.
Table 14 Intraclass correlation coefficients for testing the reliability in the image
before and after.

95% Confidence level
ICC*
0.995

Lower
Bound
0.991

Upper
Bound
0.998

0.998

0.995

0.999

Single Measures

0.998

0.997

0.999

Average Measures

0.999

0.998

1.000

Single Measures
Base(B-O) Average Measures
Veneer

ICC > 0.99 represent a very high level of standardization in both taking the images
and selecting the targeted part with Photoshop.
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Wilcoxon
test

Ranks

Table 15 Results of Wilcoxon signed-rank test for the pairs:
- Base(B-O) / Pixels (number of pixels) of plaque on the Base(B-O) before /
.
Pixels of plaque on the Base(B-O) after,
- Veneer / Pixels of plaque on the Veneer before / Pixels of plaque on the
.
Veneer after.

a
b
c
d
e
f
g
h

Negative Ranks
Positive Ranks
Ties
Total
Z
Sig. (2-tailed) h

Base(B-O)
Veneer
before / after
before / after
Mean Sum
Mean Sum
N Rank
of
N Rank
of
Ranks
Ranks
34 a 17.50 595.00 34 d 17.50 595.00
0 b 0.00 0.00 0 e
0
0
0c
34

0f
34
-5.086 g
<0.001

-5.086
<0.001

Pixels of plaque - Base(B-O) after < Pixels of plaque - Base(B-O) before
Pixels of plaque - Base(B-O) after > Pixels of plaque - Base(B-O) before
Pixels of plaque - Base(B-O) after = Pixels of plaque - Base(B-O) before
Pixels of plaque - Veneer after < Pixels of plaque - Veneer before
Pixels of plaque - Veneer after > Pixels of plaque - Veneer before
Pixels of plaque - Veneer after = Pixels of plaque - Veneer before
Based on positive ranks.
Wilcoxon signed-rank test significance.

The rotating needles device was effective in cleaning the veneers because there
was a significant decrease between POP on the veneer before cleaning (Median
=1291.25 pixel / Mean=1382.03 pixel) and POP on the veneer after using the
rotating needles device (Median=830.25 pixel / Mean=897.49 pixel), Z = -5.09, p
< 0.001. The device was also effective in cleaning the base(B-O), Z = -5.09, P <0.001,
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Median before=4507.25 pixel, after 1845.75 pixel, and Mean before=5371.18,
after=2188.25 pixel, Tables 13 and 15.

Wilcoxon
test

Ranks

Table 16 Results of Wilcoxon signed-rank test for the pairs:
- Before / POP on the Base(B-O) before / POP on the Veneer before,
- After / POP on the Base(B-O) after / POP on the Veneer after.

Negative Ranks
Positive Ranks
Ties
Total
Z
Sig. (2-tailed) h

a
b
c
d
e
f
g
h

Before
After
Base(B-O) / Veneer
Base(B-O) / Veneer
Mean Sum
Mean Sum
N
Rank
of
N
Rank
of
Ranks
Ranks
8 a 9.50 76.00 2 d 3.50 7.00
26 b 19.96 519.0 32 e 18.38 588.00
0
0c
0f
34
34
-3.787 g
-4.967
<0.001

<0.001

POP - Veneer before < POP - Base(B-O) before
POP - Veneer before > POP - Base(B-O) before
POP - Veneer before = POP - Base(B-O) before
POP -Veneer after < POP - Base(B-O) after
POP - Veneer after > POP - Base(B-O) after
POP - Veneer after = POP - Base(B-O) after
Based on negative ranks.
Wilcoxon signed-rank test significance.

Wilcoxon signed-rank test showed that POP is significantly more on the veneer
(median =50.89) than on the Base(B-O) (median = 34.86) before cleaning the RDP
68

Results
(Z = -2.72, p < 0.001). The POP is also significantly more on the veneer than on the
base(B-O) after cleaning, p< 0.001, Table 16. The median and mean values
(before/after) of POP support this result, Table 13.
Assessing the difference in the device efficacy on the base(B-O) and veneers was
conducted by using this formula which put into consideration the amount of
plaque before treatment:
Relative plaque removal (RPR) =

𝑃𝑖𝑥𝑒𝑙𝑠 𝑜𝑓 𝑃𝑙𝑎𝑞𝑢𝑒 𝑏𝑒𝑓𝑜𝑟𝑒− 𝑃𝑖𝑥𝑒𝑙𝑠 𝑜𝑓 𝑃𝑙𝑎𝑞𝑢𝑒 𝑎𝑓𝑡𝑒𝑟
𝑃𝑖𝑥𝑒𝑙𝑠 𝑜𝑓 𝑃𝑙𝑎𝑞𝑢𝑒 𝑏𝑒𝑓𝑜𝑟𝑒

x 100

Because there is a statistically significant difference in plaque accumulation
between the base(B-O) and veneer before treatment we could not use MannWhitney U test to compare the efficacy of the device on both parts of the RDP. As
alternative we have used the RPR formula after controlling the Pixels of the
targeted part in the photo before and the photo after. The formula above can be
used because the pixels of the targeted part in both images (before-after) have
excellent reliability , ICC > 0.99, table 14. Wilcoxon signed-rank test proved that
there is a significant difference, and the RPR for the base(B-O) (negative ranks =30)
is more than the veneer (Positive Ranks = 4), table 17. In other words, the rotating
needles device is more effective in cleaning the base(B-O) than the veneer.
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Table 17 Results of Wilcoxon signed-rank test for testing device efficacy on both
parts of RDP; pair:
- Relative plaque removal (RPR) in the plaque (pixels) on the Base(B-O) before and
after cleaning / RPR in the plaque (pixels) on the Veneer before and after
cleaning.

Wilcoxon
test

Ranks

RPR in the plaque on the Base(B-O)
/ RPR in the plaque on the Veneer
Mean
Sum of
N
Rank
Ranks
Negative Ranks

30 a

18.53

556.00

Positive Ranks

4b

9.75

39.00

Ties

0c

Total

34

Z

-4.419 d

Sig. (2-tailed)

<0.00 e

a RPR - Veneer < RPR - Base(B-O).
b RPR - Veneer > RPR - Base(B-O).
c RPR e - Veneer = RPR - Base(B-O).
d Based on positive ranks.
e Wilcoxon signed-rank test significance.
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6. Discussion
6.1 Discussion - study’s first objective
Although RDP plaque assessment and RDP cleansing (especially Denture) has
been the aim of a very big number of studies over the years; unexpectedly, a very
small number of studies was found to possess a moderate or high evidence-based
level (106). Moreover, in a systemic review conducted by Souza et al. 2009, which
considered the above mentioned big number, surprisingly, none of those studies
specifically aimed removable partial dentures (106).
RPD hygiene assessment is rarely carried out, because there is a need for method
standardization in both RDP hygiene assessment and RDP hygiene management
(111, 130-133). Several different methods for assessing denture hygiene have
been suggested in the current literature, but until now none has been widely
accepted, or considered the standard method of assessing RPD hygiene (130133). In general, the methods of assessing RPD plaque can be divided into 3
categories:
- Visual assessment which is suitable for patient monitoring and motivation, and
. evaluating patients’ compliance with RDP hygiene instructions.
- Planimetric assessment which can be used in the field of scientific research.
- Laboratory assessment which is useful for diagnostic purposes or scientific
. research.
Because there is a lack of evidence about the efficacy of the different denture
cleaning methods (192), we are aiming in this work to develop and test an
instrument which could be considered a standard method for assessing plaque
on all types of RDPs.
Many research used computerized methods to assess RDP plaque. Unfortunately,
not a one mentioned in detail the Standard Operation Procedures (SOP) for
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image analyses or proved that the used method is both valid or reliable. The
increasing emphasis on evidence-based health care makes it very important to
test the used method or instrument before discussing the data collected by them.
Reliability and agreement are very important quality characteristics without both
of them we could not trust the instrument.
This study showed that our SOP used in image analysis is a reliable and
reproducible instrument. The camera reprostand, standard lighting condition,
silicon key (to attach and re-attach the RDP) over a movable basis (which can be
tilted and blocked in any angel ± 45 right, left, front, back) provide a high level of
image standardization. Although some studies required 12 photos to cover all
surfaces of complete denture (141), we found that 6 photos for every RDP is
enough. Computerized image analysis -which is a type of planimetric plaque
assessment- is applied on natural teeth and complete dentures in different ways
and methods. For example, some studies used one software package, others used
two software packages ; the first software was always Adobe Photoshop. Using
two software may lead to reader error or bias, and increase the time of image
analyses. In general, all methods used two basic steps, selecting a part of the
photo (tooth or part of RDP) then selecting plaque. The first step was done in
most studies by pen tool or lasso tool (157, 195). In this study, we have used the
magnetic lasso tool because it is a quick and easy way to obtain accurate
selections and the recommended tool for the beginners (193). The second step
was plaque selection. This step was done by one of three methods:
- by drawing or selection tool which highlight the areas covered with plaque (139,
155, 194). This method is very time consuming, especially if we have a big RDP
with many small plaque islands.
- by image thresholding which adjusts the image by converting all colours and
shades to either black or white and create a grayscale image with high-contrast.
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Although we believe that it is not the optimal method, it can be argued that image
thresholding can be used with natural teeth, because there are two main colours,
white (teeth) and red (disclosed plaque). Unfortunately, we cannot use this
method with RDP because we have different degree of red in the image, which
ranged between dark red (disclosed plaque) to red or light red (RDP base).
- by colour selection. Smith et all. had used this option in Photoshop to quantify
plaque on natural teeth. And he set the fussiness at 100 (50 shades above and
below the selected pixel) to automatically highlight the red disclosed plaque
areas. This setting is not suitable in case of RDP because it will highlight both
plaque and RDP base. In our study, colour-range option was used with a
predetermined fuzziness setting of 10. Therefore the examiner selection is more
precise as it contains a small range of colour. On the other hand, he should make
more than one selection to cover all the targeted areas in the image, therefore it
is more time consuming.
The Computerized Planimetric Method (CPM) used in this study demonstrated
excellent intra-examiner and inter-examiner reliability. ICC values were ≥0.9,
suggesting sufficient reliability for making decisions (195). Similar high reliability
was recorded in other studies. Smith et al. who used SOP closed to the one used
in this study, reported high intra-examiner and inter-examiner reliability. They
reported reliability (ICC) of quantifying plaque on the buccal front natural teeth
between 0.82 to 0.99 (196), and on the lingual natural tooth surface 0.89 to 0.98
(183). However, Smith et al. method cannot be applied on RDP because he
recommended high fuzziness. Our data showed intra-examiner ICC values higher
than inter- examiner ICC values. That may be explained by a learning effect of the
examiners. These results are similar to the findings from prior studies (183, 196,
197).
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To assess the effectiveness of a certain method in plaque removal from RDP
or to monitor improvement of RDP hygiene in clinical practice, and
epidemiological or clinical trial studies, the magnitude of the measurement error
might be of more interest than the reliability parameters values such as ICC. Both
SEM and SDC can help the clinician to determine if the patient truly complies with
the recommendations and instructions, and aid the researcher in evaluating the
cleaning method. Moreover, some researcher believe that SEM is a better
measure of the quality of an assessment than is reliability (198). Because
reliability alone can produce a paradoxical and distorted picture, particularly in
the situation where a small number of subjects participate in the study. On the
other hand, SEM is recommended to measure the quality of an assessment
because it is not subject to such hitches (198). The SEM intra- and inter-rater
values were respectively ≈ 3 – 6%. This means that the instrument has a low to
acceptable level of measurement error which reflect a good quality of denture
plaque assessment, because we are 95% sure of the value ±2x(3 or 6)%.
The SDC intra- and inter-rater values were respectively ≈ 10 – 16%. This means,
we are 95% sure that a change in RDP plaque coverage exceed 10 - 16% of the
examined area can be detected by our instrument. The decision, if this level of
sensitivity is enough or not, is left to the user of the instrument. Until now, there
are now other similar studies to compare with. However, it is important to
mention that,

Shaloub & Addy revealed that

most examiners tended to

overestimate plaque areas over natural teeth when they used visual assessment
(index) (155). Paranhos et al. proved that Jeganathan et al. and Budtz-Jørgensen
indices overestimated the plaque coverage area over denture, when compared
to a computerised method (151).
It is most unlikely that different examiners will agree exactly, by giving the
identical result for all images. Therefore, we have used Bland and Altman plot to
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know how every examiner is likely to differ from the main examiner. Bland and
Altman proposed a method, which is frequently used to assess the limits of
agreement between two examiners or two different methods (188, 189). In order
to accurately estimate the limits of agreement between 2 examiners, a big
sample size is required. According to Bland's recommendations, 100 subjects
(photos) are adequate. In this study, 111 was the sample size to determine
reproducibility of colour /plaque selection. The bias doesn’t exceed 1.4%, and the
one-sample t test proved that there is no presence of fixed bias. Besides, a good
agreement for most values can be easily recognized in the three plots, Fig. 4, 5
and 6. The outlier for the second, third and fourth examiner were 3, 7, and 4
respectively. Although the third examiner has the biggest number of outlier, it
has the best level of agreement. Therefore, we can confirm that the results
collected from the same images by different examiners have a high level of
agreement.

6.2 Limitations
Image analyses was performed by standard examiner and 3 other students.
Although they were in the final stage of their study, their experience in RDP
plaque assessment and image analyses is obviously less compared to experienced
clinician. As a consequence, they may have looked differently at the images, to
decide what should or shouldn’t be selected.
The fact that the CPM has a limitation because it is completely relying on two
dimensional images, cannot be ignored.
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6.3 Discussion - study’s second objective
RDP plaque is considered an important reservoir of organisations which could
induce local oral diseases such as denture stomatitis or papillary hyperplasia (77,
93).
Many recent studies demonstrated mutualistic interactions / relationships /
associations between oral plaque/oral health/periodontitis and systemic diseases
such as diabetes, tissue repair capacity, immune cell functions……. (101, 102).
Oral plaque microorganisms may disseminate through the blood to infect the
vascular endothelium and contribute to the occurrence of atherosclerosis and risk
of myocardial ischemia and infarction (103).

Sumi et al. proved the high

correlation between the bacterial species in denture plaque and pharyngeal
microflora (104). Besides, denture plaque could serve as a resource for pathogens
cause disseminated infections such as gastrointestinal infections (105).
The new studies enhance our understanding of the importance of oral health and
its connection to the patients’ overall health and their intraoral and general
diseases. Diseases which can be treated not only by targeting the putative
pathogens, but also prevented with proper oral and RDP cleaning.
RDPs can be cleaned mechanically or chemically (106). Mechanical methods can
be further subdivided into: manual (by hand) or machinal (ultrasonic device or
rotating needles device). By literature review, it was noticed that there is no study
tried to evaluate the efficacy of the rotating needles device.
We are aiming in the second object to test the computerized planimetric method
– which was the first object of the theses - by evaluating the efficacy of the
rotating needles device in cleaning specific parts of RPD:
- the vestibular flange and the occlusal and vestibular surfaces of the
artificial teeth (base(B-O)),
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- and the veneer (facing) of the secondary crown in double crown retained
removable denture.
It was noticed that POP is significantly more on the veneer than on the base(B-O)
before and after cleaning the RDP. This result is supported by many other studies
which proved that plaque accumulation is varied between different parts of the
RDP. Fermandes et al. reported an intense biofilm accumulation, mainly at the
site of union of the teeth with the denture base (182). Augsburger and Elahi study
pointed out that convex and smooth surfaces present lower biofilm levels than
those artistically sculptured and with sharp finishing (134). Tarbet, et al. in a
comparative analysis of denture hygiene products, found significant differences
between the internal and external surfaces (right and left buccal flanges). They
stated that biofilm on the internal unpolished surface is significantly more than
the external polished surface (199). The effect of surface polishing on plaque
accumulation was tested by Keenan et al. who proved that plaque deposition rate
decreases as surface polish level increases (200).
Resin-based composites are the preferable material for making the veneers
(facings) on the secondary crowns of double crown retained dentures. The
material possesses higher elastic modulus and proved to have a greater degree
of safety in double crown retained dentures than ceramic (201). Unfortunately,
resin-based composite display a number of flaws, like plaque retention,
discoloration, relatively weak bond between the metal base and veneers, and low
resistance to abrasion (202-206). This could explain the significant difference in
POP between the veneers and base(B-O).
It was noticed in the literature review that some researcher had used the
difference (value before minus value after) to compare between treatments
(groups) (207, 208). Although we believe that it is not the optimal method, it can
be argued that the previous approach can be used if there is no significant
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difference in the distribution of the analysed parameter between the groups
before treatment. To give an example, why it is not advisable to use the raw
difference to compare the efficacy of treatments between groups with different
pre-treatment distributions, let’s say that we have these three pairs of group
means (before-after); (60-30), (80-40), and (90-45). The raw differences are 30,
40, and 45, but the improvement after the treatment is always the same: 50%.
Since the distribution of pixels of plaque before treatment was different on base(BO)

and veneer, we used the relative plaque removal (RPR) formula. By doing so,

we put into consideration the different amount of plaque before treatment.
However, for using the RPR formula it must be ensured that the number of pixels
on the targeted part of the RDP before and after treatment is approximately
stable. This means a high level of standardization and reliability in both taking the
images and selecting the targeted part with Photoshop software is needed.
In this part of the theses, the statistic level of analyses was the subject. If the
subject has two RDPs only one was randomly selected. The statistic unit was not
the Photoshop layer as in the first objective, or the image, or the RDP, because
they are not independent variables, which is essential for many single-level
statistical methods (209). Due to the clustering of layers within the same image,
and images within the same RDP, and two RDPs within the same participant, a
correlation may exist between variables in the same cluster. In other words, if the
patient hygiene is good, both RDPs will have low values of POP and vice versa.
Although, considering both RDPs would increase the sample size; this may distort
the distribution in the same cluster and lead to biased estimates. To correctly
analyse the data, the correlation in the same cluster was taken into account by
randomly selecting one RDP if the subject had two.
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The used parameter for evaluating the respective RND efficacy in cleaning the
veneers, and in cleaning the base(B-O), were the pixels and not the POP. But from
a statistical point, using the POP would give exactly the same results as using the
pixels because in Wilcoxon signed-rank tests (which is the non-parametric
alternative to the paired t-test), for each pair of values, the relation of the
respective values is considered, which is not affected by transforming both values
in the same way (e.g. from pixels to POP if the number of pixels on the RDP before
and after treatment is stable). Nevertheless, we believe that using the pixels
would be more appropriate if the conditions for parametric tests are met. For
example, in the paired t-test, the values themselves are considered, not their
ranking. In other words, our study scenario may not be repeated in other studies
if they have a normally distributed data. One assumption in many statistical tests
is that the data are free to vary widely about the mean - there are no imposed
limits. Clearly, this is not the case if we use POP, which cannot be less than 0 nor
more than 100. However, in comparing plaque accumulation between base(B-O)
and veneer, the POP had to be used due to the difference in the size (and
therefore also in the number of pixels) between the two parts of the RDP. The
relatively small size of the veneer will produce a small number of pixels, Table 13.
And using the POP in this case can quantify the plaque correctly.
Although we have 6 images for every RDP before and 6 after, we have used in
the second objective of the theses only one or two images (right/left) before and
the same number after. Selecting the most appropriate image for analyses was
performed under two criteria: the most appropriate and clear image of the
targeted part; secondly, no overlap of the targeted part between the images.
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7. Conclusion
7.1 Conclusion - study’s first objective
The Computerized Planimetric Method (CPM) have been applied with
increasing success in the fields of science and medicine because of its objectivity,
reliability, and high level of standardisation.
Within the limitations of this study, it can be concluded that our SOP for image
analysis has an excellent inter- and intra-examiner reproducibility, good level of
examiners agreement, acceptable level of sensitivity, acceptable measurement
error, and good quality of denture plaque assessment. Above all, it can be used
with all types of RDPs.
The method is time consuming, therefore it is more suitable for clinical
researches. The method required examiner trained by clinician to decide what is
truly stained plaque, and also required image analysis training before mastering
the method.

7.2 Conclusion - study’s second objective
Wherever possible, parametric models are preferable to non-parametric
methods because of their higher statistical power. When doing so, answering the
study question by using the number of pixels instead of POP is recommended if
the number of pixels on the targeted part of the RDP does not differ between
images before and after.
The results of this study indicate that plaque accumulation is significantly
higher on the double crown veneer than on the base(B-O). Therefore, extra
attention should be given to the veneer over the secondary crown as they are a
potential part for RDP plaque accumulation.
The RND is significantly effective in cleaning the veneer and the base(B-O), but
more effective in cleaning the base(B-O).
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8. Summary
Objectives
The aim of the study was to develop and evaluate the reliability and agreement
of new computer planimetric method for measurement and assessment of
plaque on all types of removable dental prostheses RPDs.
The instrument (new method) was tested by evaluating the efficacy of the
rotating needles device in cleaning specific parts of RPD

Materials and Methods
From a database containing 780 images, which were taken in a standardized
method for 65 RDPs for 49 participants, 55 images were selected randomly for
image analysis. Adobe Photoshop software was used according to a standard
operating procedure (SOP) by a main examiner two times in different sessions,
and 1 time by 3 other examiners. In order to estimate the intra- and interexaminer reliability, intraclass correlation coefficients ICC(2,1) was used. Three
parameters were used to estimate agreement: standard error of measurement
(SEM), smallest detectable change at 95% confidence level (SDC95%), and limits of
agreement (LoA) according to Bland–Altman method.
In the database, only 34 subjects were found with double crown retained
removable denture and veneer over the secondary crown. 49x2 (before x after)
images for 34 RDPs went under image analyses to calculate POP before and after
cleaning the RDPs with the rotating needle device. Data were analysed using
Wilcoxon signed-rank test.

Results
In all steps of image analysis, both intra-examiner and inter- examiner reliability
were excellent with ICC(2,1) values > 0.85 at 95% confidence level. Intra- and inter-

81

Summary
examiner values for both, SEM and SDC95% were ≤ 6% and ≤17% respectively. The
Bland–Altman analysis revealed a satisfactory level of agreement.
POP is significantly more on the veneer than on the base(B-O), P <0.05. The
rotating needles device is effective in cleaning the veneer and base(B-O), P <0.05
with absolute effect size 0.62. No statistical significance was detected in the
effectiveness of the rotating needles device between base(B-O) and veneer.

Conclusion
This study showed an excellent inter- and intra-examiner reproducibility,
satisfactory level of examiners agreement, and acceptable measurement error of
the new computer planimetric method . Furthermore, the method can be used
with all types of RDPs.
The rotating needles device can significantly reduce plaque on the double
crown retained removable denture.

Clinical significance
The Computerized Planimetric Method (CPM) is more suitable for clinical
researches because of its objectivity, reliability, high level of standardization, and
the ability to detect and quantify small changes in plaque.
Extra attention should be given to the veneer over the secondary crown as they
are a potential part for RDP plaque accumulation.
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15.1 Standard Operating Procedure (SOP)
Image analysis to assess plaque on removable dental prostheses
This SOP provides a step-by-step instructions to guide you easily through each
task. It will show you how to perform each task correctly in Adobe Photoshop
Version:CS5 EXTENDED 12.0X32
A. Browsing folders and opening images: Clicking the File tab will open the
computer's drives and folders, enabling the examiner to navigate the computer's
folders to locate the image that he want to view.
B. Duplicate layer (your image):
In the Layers panel, you can see your image as a layer.
Select your layer (image) in the Layers panel→ click the right button of the
mouse → choose duplicate layer.
C. Selection:
In this step, the examiner isolates one or more parts of the image, by selecting
specific areas. In the image, we could see the metal, acrylic veneers on double
crowns, acrylic resin bases and artificial teeth. We select only the acrylic veneers
and acrylic resin bases with artificial teeth using the Magnetic Lasso tool. The
Magnetic Lasso tool is one of three lasso tools available in Photoshop: the simple
Lasso tool, the Polygonal Lasso and the Magnetic Lasso. The Magnetic Lasso tool
can be found as the third icon from the top in the toolbox.
After choosing the Magnetic Lasso tool, the features in the options' bar should be
set as demonstrated in Table 1.
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Table 1 The values in the options bar of the Magnetic Lasso tool.

Options

Values

Feather

0 PX

Anti-alas

Do not click this option

Width

10 PX

Contrast

10

Frequency

50

Tablet Pressure Do not click tablet pressure
Refine Edge

Do not refine edge

How do we use the Magnetic Lasso tool? Click the edge of the targeted part to
set the first fastening point. Fastening points anchor the selection border in place.
Release the mouse button and then move the pointer along the edge you want
to trace. As you move the pointer, the active segment snaps to the strongest edge
in the image, based on the detection width set in the options bar. Periodically, the
Magnetic Lasso tool adds fastening points to the selection border to anchor
previous segments. If the border does not snap to the desired edge, click once to
add a fastening point manually. Continue to trace the edge, and add fastening
points as needed. To erase recently drawn segments and fastening points, press
the Delete Key until you’ve erased the fastening points for the desired segment.
Close the border manually with a magnetic segment, by dragging over the starting
point and clicking. After you close the border copy, paste your selection to create
a new layer.
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D. Select a colour range (plaque selection):
Colour Range selection can be used to create selections that are based on similar
colour values. Opening the Colour Range panel can be achieved by clicking
Select → Colour Range. In the colour range window, the Sampled colours tool
from the Select menu should be chosen, and both the Localised Colour Clusters
box and the invert option box are unchecked.

The Fuzziness value has a major effect on the colour range selection; therefore,
the Fuzziness slider should not be changed, and should remain the same in all
images. In this study, the Fuzziness was 10. The first selection starts with the
darkest red part of the image. Then the plus eyedropper selects lighter red to
expand the colour range until all needed spots (plaque) in the layer are included.
If there are spots or areas that should not be included in the selection, the minus
eyedropper is used.
Assessing the selection is accomplished by choosing White and Black Matte in the
Selection Preview menu.
After reaching the optimal selection, OK is clicked, and subsequently a new layer
is created by the copy and paste, Fig. 1.
In some rare cases, the Localised Colour Clusters (in the colour range box) is used
to avoid selecting unwanted areas in the image. This will increase the number of
the needed selection, but it will make the selection more satisfactory.
Exceptionally, the eraser tool is used to remove unwanted selected areas. Pencil
Mode and Opacity of 100% in the options bar are selected during this step.
The examiner makes 2 colour selections to control his work. If he is not satisfied,
he should make a third and last selection. The mean of these two or three
selections is considered the final result.
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Fig. 1. Basic steps of the image analysis:
A. Combined attachment- and double
crown-retained RDP.
B. Selection: The examiner isolates
one or more parts of the image.
C. Plaque selection: By using the
colour range selection the examiner
can make selections based on the
colour of the disclosed plaque.
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5. Saving, closing and then reopening:
Saving the work by clicking (File → Save as), this will save all the work as a PSD file.
Finally, reopen the PSD file to record the number of pixels.
Closing and then reopening the PSD file give the software the ability to determine
the correct number of pixels.
6. Counting the total number of pixels in the selected layer:
This can be accomplished by opening the histogram panel. Choose Window →
Histogram, and then click the Histogram menu and check both Expanded View
and Show Statistics.
In the Histogram panel, these two choices should be made:
- In channel, select the (colours).
- In source, select the (selected layer).
In the Histogram panel, the number of pixels is presented.
The percent of plaque (POP) on the targeted part of the RDP is calculated using
the following formula:
POP on the targeted part of RDP =

Pixels of Plaque
Pixels of the targeted part

x 100

If the targeted part of the RDP is divided over more than one image, the below
formula is applied:
POP on the targeted parts of RDP =

∑Pixels of Plaque [image 1+2+3+⋯ ]
∑Pixels of the targeted part [image 1+2+3+⋯ ]

X 100

Do not use the last formula if the targeted part overlap between the images.
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